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Audience

Preface

The Agile Product Lifecycle Management for Process Install/Upgrade Guide contains
instructions for installing and upgrading Oracle Agile Product Lifecycle Management
(PLM) for Process.

This preface contains these topics:
= Audience

= Variability of Installations

= Documentation Accessibility
= Related Documents

s Conventions

This guide is intended for end users who are responsible for creating and managing
information in Agile PLM for Process. Information about administering the system
resides in the Agile Product Lifecycle Management for Process Administrator User Guide.

Variability of Installations

Descriptions and illustrations of the Agile PLM for Process user interface included in
this manual may not match your installation. The user interface of Agile PLM for
Process applications and the features included can vary greatly depending on such
variables as:

= Which applications your organization has purchased and installed
= Configuration settings that may turn features off or on
»  Customization specific to your organization

= Security settings as they apply to the system and your user account

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading



technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services

To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer
Assistant will relay information between the customer and Oracle Support Services at
1.800.223.1711. Complete instructions for using the AT&T relay services are available at
http://www.consumer.att.com/relay/tty/standard2.html. After the
AT&T Customer Assistant contacts Oracle Support Services, an Oracle Support
Services engineer will handle technical issues and provide customer support according
to the Oracle service request process.

Related Documents

For more information, see the following documents in the Agile PLM for Process
Release 6.1 documentation set:

»  Agile Product Lifecycle Management for Process Administrator User Guide

»  Agile Product Lifecycle Management for Process Global Specification Management User
Guide

»  Agile Product Lifecycle Management for Process Supply Chain Relationship Management
User Guide

»  Agile Product Lifecycle Management for Process Document Reference Library User Guide

»  Agile Product Lifecycle Management for Process Release Notes. Up-to-date Release
Notes and other documentation are posted on Oracle Technology Network (OTN)
at this location:

http:/ /www.oracle.com/technetwork /documentation/agile-085940.html#plmpro
cess


http://www.oracle.com/technology/documentation
http://www.oracle.com/technology/documentation
http://www.oracle.com/technology/documentation

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Installation

This chapter discusses Agile PLM for Process installation and includes the following
topics:

Overview

Installation Requirements
Pre-Installation Checklists
Installation

Post-Installation Checklists

Installing Agile PLM for Process involves several steps, including;:

Understanding system requirements

Performing pre-installation tasks (such as setting up the Web application server
and database)

Running the command prompt installation batch files

Performing post-installation tasks, such as:

= Configuring the remote container service

s Performing some base application environment configurations

s Testing the installation

Note: Some tasks required to complete this installation are technical
in nature. Please refer to Appendix E, "Skill Set Matrix" for a list of
skills recommended for completing tasks included in this guide.

Checking for Latest Information and Instructions

Prior to installation please refer to the following URLSs for the latest information and
instructions:

1.

Oracle Software Delivery Cloud: http:/ /edelivery.oracle.com/. Oracle Software
Delivery Cloud provides the latest copy of the core software. Please note the core
software does not include all patches and hotfixes.

a. Select appropriate language and click Continue.
b. Complete the export validation requirements form.

c. Select “Oracle Agile Applications” as the Product Pack.

Installation 1-1



Checking for Latest Information and Instructions

g.

Select “Microsoft Windows (32-bit)” as the Platform.
Click Go.

Search for “Oracle Agile Product Lifecycle Management for Process 6.1.0.0.0
Media Pack” in Results and select link.

Download the appropriate media packs.

2. Oracle Support: https://support.oracle.com. Oracle Support provides the latest
patch releases and hotfixes. To gain access to the latest patches and hotfixes
perform the following steps:

a.

f.

Log into https:/ /support.oracle.com. If you do not have a user ID please
contact Oracle Support.

Select a language from the Language drop-down, and then click Sign-In.
Go to Patches & Updates.

Under Patch Search, click “Product or Family (Advanced Search)”

— Productis “Oracle Agile Product Lifecycle Management for Process.”

— Release is “{The release you are interested in}”, i.e. “Agile PLM for Process
6.1.0.0.0”

— Platform is “Microsoft Windows (32-bit)”

Click Search. The latest patches and hotfixes will be provided in the search
results.

Download the appropriate patch releases or hotfixes.

3. Oracle Technology Network (OTN):
http:/ /www.oracle.com/technetwork/indexes/documentation/index.html. OTN
contains documentation for Agile PLM for Process.

a.

Access
http:/ /www.oracle.com/technetwork/indexes/documentation/index.html.

Under the Oracle Applications section, scroll down to “Other Applications”
and select the Oracle Agile link. A new window opens.

Click Agile PLM for Process Documentation to see a listing of available
documentation.

4. Oracle Mix: https://mix.oracle.com/groups/16252. Visit the Prodika Lounge for
the latest posts from customers, partners and Oracle’s Product Management
regarding the PLM for Process product line.
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Installation Requirements

Installation Requirements

This section discusses Agile PLM for Process installation requirements for the client,
application server, and database server. Make sure your systems meet all installation
requirements before attempting to install the Agile application suite. In order to
properly run, Agile PLM for Process requires a Web client, a Web application server, a
remoting container (provided by Agile), and a database server. Figure 1-1 shows the

necessary architecture.

Figure 1-1 Agile PLM for Process Physical Architecture

Web Clients

Application
\ servers

Remoting
Container

N

Datab
8
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Installation Requirements

Requirements Overview

Figure 1-2 shows an overview of software requirements.
Figure 1-2 Software requirements matrix
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Installation Requirements

Web Client Requirements

To properly run Agile PLM for Process, web clients must meet the following minimum
requirements:

» Internet Explorer 7.0, 8.0, or 9.0
s Adobe Reader 7.0

Warning: When determining server hardware requirements as
described below in "Web Application Server Requirements", "SQL
Server Database Server Requirements", and "Oracle Database
Server Requirements", keep in mind that these are minimum
requirements. Your environment should be evaluated to determine
the actual hardware requirements. Things to consider are:

- Data volume

- Application distribution

- Application usage

- User load

- User distribution across applications
- Network configuration

- Document storage location

Web Application Server Requirements

Software Requirements

Agile PLM for Process runs on Windows 2003 Server SP2 (32-bit) and Windows 2008
Server SP1 and R2 (32- and 64-bit). To properly run Agile PLM for Process, use one of
the following supported versions for the web application server:

» IS 6.0 on Microsoft Windows™ 2003 Server SP2
» IS 7.0 on Microsoft Windows™ 2008 Server SP1
» IS 7.5 on Microsoft Windows™ 2008 R2

s Microsoft .NET Framework 3.5 SP1

Hardware Requirements

To properly run Agile PLM for Process, the web application server must meet the
following minimum requirements:

s Dual CPU Intel Xeon 3.0 GHz and above
s  2MBL2 cache
» 4GBRAM

Each application in the Agile application suite can be hosted on one or more web
application servers.

Note: We recommend that you use separate application pools if the
same web application server is shared across Agile applications.
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Installation Requirements

Typical Production Hardware Requirements

Hardware requirements for a typical production environment are as follows:
s Dual CPU Intel Xeon 3.0 GHz and above with at least 2 cores

s 2MBL2cache

= 8 GBRAM

SQL Server Database Server Requirements

Software Requirements

To properly run Agile PLM for Process, use one of the following supported versions
for the database server:

= Microsoft SQL Server™ 2005, SP2 or higher
= Microsoft SQL Server™ 2008, SP1 or higher
s Microsoft SQL Server™ 2008 R2

Hardware Requirements

To properly run Agile PLM for Process, the SQL database server must meet the
following minimum requirements:

s Dual CPU Intel Xeon 2.0 GHz and above
» 2MBL2 cache
= 4GBRAM

»  Separate drives for data and log files

Note: The database server can be managed in a clustered
environment.

Typical Production Hardware Requirements

Hardware requirements for a typical production environment are as follows:
s Dual CPU Intel Xeon 3.0 GHz and above with at least 4 cores

s 2MBL2cache

= 16+ GBRAM
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Installation Requirements

Oracle Database Server Requirements

Software Requirements

To properly run Agile PLM for Process, use the following supported versions for the
Oracle database server:

s Oracle Database Server: 10g Release 2 (10.2.0.4), 11g

s Oracle 11g Client + ODP.NET 11.1 (On the IIS server, as described in
"Pre-Installation Environment Configuration" on page 1-10)

Note: Currently only the 32-bit ODP client is supported.

»  Operating system supported by the Oracle database. Please note, the 11g client is
required whether you implement Oracle DB 10g or 11g.

Hardware Requirements

To properly run Agile PLM for Process, the Oracle database server must meet the
following minimum requirements:

s Dual CPU Intel Xeon 2.0 GHz and above
s  2MBL2 cache
» 4GBRAM

= Separate drives for data and log files

Typical Production Hardware Requirements

Hardware requirements for a typical production environment are as follows:
= Dual CPU Intel Xeon 3.0 GHz and above with at least 4 cores

s 2MBL2cache

= 16+ GBRAM

Remoting Container Requirements

With the Agile application suite, you receive the Agile Remoting Container, a
Windows OS-level service. This remoting container can exist on the same Web
application server described above, or separately. The following are requirements for
the remoting container:

s Microsoft .NET Framework 3.5 SP 1

For more information, refer to the Agile Product Lifecycle Management for Process
Remoting Container Services Guide.
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Scaling Requirements

You will need to scale your system for performance and availability as your system
begins to grow due to an increased use of the Agile application suite and a growing
number of users and as your business demands change or increase. The following
sections provide scalability recommendations.

Scaling for Performance

You will need to scale for performance as the number of users and applications begins
to increase over time. In consideration of performance scaling, we recommend the
following:

= No more than 250 registered users per processor.

= Organize scaling according to regional user patterns (according to users in similar
time zones and geographical regions).

= Once physical Web application server limitations are met, use a load-balanced
(logical or actual) solution.

Scaling Beyond Five Core Applications

The following are recommendations for scaling beyond five (5) core Agile applications.
Core Agile applications include:

- Global Specification Management (GSM)

- Supply Chain Relationship Management (SCRM)
- New Product Development (NPD)

— eQuestionnaire (eQ)

- Agile applications portal

= Run no more than five (5) core Agile applications on a single Web application
server.

s Organize scaling based on an evaluation of utilization patterns (known application

characteristics).

Load Balancing As mentioned above, once physical Web application server limitations
are met, use a logical load-balanced solution based on application distribution across
servers. For example, a logical separation might be organized by application as
follows:

GSMAppGroup — Includes GSM and other complimentary applications
NPDAppGroup — Includes NPD and other complimentary applications

Scaling for Availability

You may also need to scale for availability as your business demands begin to change
or increase over time.

For application load-balancing, we recommend the following:

= Aload balancer (such as f5 BiglIP or Cisco C5511000) that supports the following;:
- Secure Sockets Layer (SSL) protocol
-  Sticky sessions

= A maximum of five core Agile applications per load-balanced node.
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Note: A clustered node is an expansion of a logical application
separation.

For database, file, and service clustering, we recommend the following:
= A clustered server to support an active or passive database system
= A file cluster (where required)

= Service clustering
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Pre-Installation Checklists

This section discusses Web application server-related tasks that an Agile implementer
must complete before installing the Agile application suite.

The application is configured out of the box to use Integrated SSPI. This technology is
used to ensure the username and password is not stored as clear-text in any
configuration files and is only applicable to environments using Microsoft SQL Server.
This guide will only refer to settings as they pertain to SSPI. Please refer to the Agile
Product Lifecycle Management for Process Security Configuration Guide for secure Oracle
DB setup and unsecure clear-text method.

Note: The clear-text method should ONLY be used in a
non-production environment as your username and password is
stored in clear-text in the configuration file.

Pre-Installation Environment Configuration

User Creation

A local or domain application user needs to be created. We will use PLM4P_AppUser
for the purposes of this document. PLM4P_AppUser will need access to the following:

= Files
= Read access to the PRODIKA_HOME directory
= Read/Write access to the PRODIKA_HOMEN\logs directory
m  Read/Write access to the PRODIKA_HOME\XDocuments
= Read/Write access to WebDAV directory for NPD
= Read/Write access to system temp directory (i.e.. c:\windows\temp)

= Full control over PRODIKA_HOME\RemotingContainer

= Identity for Application Pool
- ForIIS 6.0, add user to IIS_WPG group
- ForIIS7.x, add user to IIS_IUSRS group
= Service
= Execute and Run the Remoting Container Service
s MSSQL Database
s db_datareader
s db_datawriter

s db_executor

Note: XDocuments and WebDAYV are configurable settings and may
exist elsewhere within your environment. Once installed, please refer
to the Agile Product Lifecycle Management for Process Configuration Guide
for location and details.
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Microsoft Application Server Checklist

Before installing the Agile PLM for Process application suite, complete all of the
Microsoft IIS related tasks in the following sections:

= Add Application Server Role

s Create and Configure IIS Application Pool Settings
s Create and Configure a Website

= Enable WebDAYV for NPD Applications

= Enable IIS6 or Apache 2.2 for NPD Application

Add Application Server Role

Refer to Microsoft Windows Server documentation for deploying the server role,
Application Server (IIS, ASP.NET).

s For Microsoft Windows 2003, install IIS 6.0. Post installation, in IIS Manager, under
Web Service Extensions, allow ASP.NET 2.0.50727.

»  For Microsoft Windows 2008, install IIS 7.x. During installation, be sure to select
the following options:

= ASPNET
s IS 6.0 Management Compatibility

Post installation, in IIS Manager, under ISAPI and CGI Restrictions, allow
ASP.NET 2.0.50727.

Create and Configure IIS Application Pool Settings

Application Pool names are for example, and can be renamed if needed.

Create at least two Application Pools called PLM4P_MAIN and PLM4P_GSM with
the following settings modified.

IIS 7.x Setting IIS 6.0 Setting Value

Enable 32-Bit Applications n/a True

Managed Pipeline Mode n/a Classic

Queue Length Request queue limit 4000

Identity (Custom Account) Identity (Configurable) PLMA4P_AppUser
Idle Time-Out n/a 0

Regular Time Interval Recycle worker process 0 (uncheck)

Ping Enabled Enable pinging false

Rapid-Fail Protection Enable rapid-fail protection false

It is highly recommended that GSM is setup in its own Application Pool. Based on the
applications installed and used in your environment, you can set other applications to
use their own Application Pools in order to maximize memory allocation and
performance.
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Note: Identity can be set to Local System in non-production
environments that are not utilizing Integrated SSPI for the DB
connectstring. Please see the Agile Product Lifecycle Management for
Process Security Configuration Guide for more information.

Create and Configure a Website
Website name defined below is an example and can be renamed if needed.

Create a website called PLM4P with the application pool set to PLM4P_MAIN and a
Physical path of 'C:\inetpub\wwwroot '. For a production environment, this site
will need a valid SSL certificate to protect against data traversing the network in
clear-text. Please refer to the Agile Product Lifecycle Management for Process Security
Configuration Guide for more information, as well as, information on how to setup
without SSL for non-production environments.

Enable WebDAV for NPD Applications

If you are installing the Agile PLM4P NPD application, you must enable the WebDAV
(Web Distributed Authoring and Versioning) protocol in Microsoft IIS to support
in-place editing. Please refer to Appendix B, "Installing WebDAV" for instructions.

Warning: WebDAV is fundamentally different in IIS7.x and is not
a supported platform when using anonymous user. If you are
installing the main application on IIS7.x, then you must have a
separate web server with IIS6 or Apache 2.2 installed for WebDAV.

Configure Microsoft SQL Server

Refer to Microsoft SQL Server documentation for installation instructions. For
information on MS SQL Reporting Server, which can be optionally installed, refer to
the Agile Product Lifecycle Management for Process Configuration Guide. When installing,
ensure the collation designator and sort order are Latinl_General.

Oracle Database Server Checklist

= Create the Oracle database server using Oracle Database Configuration Assistant.

s Choose AL32UTFS8 as the database character set and UTFS8 as the database
national character set.
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Oracle Database Client Checklist

The following Oracle Database Checklist can be used in conjunction with Oracle
Database documentation containing installation instructions. Clients should use this
checklist or the instructions in "Configure Microsoft SQL Server" on page 1-12, but not
both, as they are separate installation methods. When installing the Oracle client, be
sure to:

s Install Oracle 11g Release (11.1.0.6 +) client on the server hosting the application.

= Update the tnsnames.ora, located at %Oracle Client
Home% \network\admin \tnsnames.ora, to include a new data source. This data
source should point to the Oracle database that has been set up.

= Build your connection string:

“User Id=<user id>;Password=<password>;Data Source=<data
source created in step 4>” where

a. Userld=db username
b. Password = passwd

c. Data Source = The name that you gave your tnsnames.ora entry

SSL Checklist

SSL (Secure Sockets Layer) is a protocol from Netscape Communications Corporation
that is designed to provide secure communications on the Internet. SSL is not required
for an Agile installation but is strongly recommended for production environments.

SSL can be deployed in many ways. Most commonly, SSL will run within IIS or on an
intermediary system such as a Reverse Proxy or SSL accelerator.

The Agile application suite can operate in any of these scenarios, but the HTTP scheme
must be configured (via environmentvariables.config) to generate the desired
relative URLs correctly (http vs. https). The default URLs are configured for https.

East Asian Language Support

If you plan to support East Asian languages in Agile Product Lifecycle Management
for Process, you must install East Asian language support on the server.

To install East Asian language support on the server:
1. Access the Windows Control Panel dialog box by clicking Start > Control Panel.

2. Select Date, Time, Language, and Regional Options > Regional and Language
Options and click the Languages tab.

3. Check the Install Files for East Asian Languages box.
4. Click Apply and OK.

Restoring the SQL Database and Setup Database Accounts

A prepared database is provided as part of your Agile software media from Agile
Software. Using Microsoft SQL Server Management Studio, you will need to restore
this database onto your local database server. You will also need to make sure that the
user responsible for accessing the database has the appropriate account setup and
assigned roles.
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Option 1: MSSQL Database

Restoring the Database

Refer to Microsoft SQL Server documentation for restoring a database.

The name and location of the database is <media pack>\Database\Certified_
DB_<version>.zip

Note: If you do not already have a naming convention, we
recommend including the environment name. for example: plmdp_
production

Setting Up User Permissions
Refer to Microsoft SQL Server documentation for setting up a user.

Recall and add the user created as part of the pre-installation environment checklist.
For example, PLM4P_AppUser. At a minimum, this user must have the following two
roles for the plm4p_ database:

s db_datareader

s db_datawriter

Option 2: Oracle Database
To restore the Oracle database:

1. Create an Oracle database user. A SQL script is provided to create the database
user and set up user permissions for the application. Run the SQL script
createuser.sql using Oracle SQL*Plus.

2. Note that the imp client version has to match exactly the Oracle database server
version. The client character set also needs to be set to the server character set.
Import the Oracle database dump file certifiedDB_v6100 .dmp from the
command window:

C:> set NLS_LANG=AMERICAN_AMERICA.AL32UTF8
C:> imp <ORCL dbuser>/<ORCL dbpwd>@<datasource> fromuser=<agile> touser=<target
dbuser> file=<dmp file> log=<log file>
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Installation

The Agile PLM suite is installed through a set of manual configuration steps. Several
of the steps are automated with utility batch scripts for a default configuration. The
overall process consists of the following steps:

Setting up PRODIKA_HOME

Installing the Core Application Files

Registering Environment Components

Setting the Remote Container Service and Application Pool Accounts
Installing Individual Media Bundle Application Files

Setting Up the Initial IIS Application Pools

Register the IIS virtual directories for the installed applications
Registering .Net version 2.0 under ASP

Installing the Reference Database

Installing Language Support for Simplified Chinese, Traditional Chinese, Korean,
or French

Configuring Applications
Installing BI Publisher (Optional)
Completing Optional Steps
Determining a Web Site’s Site ID

Installation Process

Setting up PRODIKA_HOME

1.

Note: This step needs to be done only once per Web site instance. If
you have multiple instances of the Agile PLM suite running on the
same server, you will need to perform this step once per instance.

Create a folder (e.g. c:\PLM) into which to install the application. For instructional
purposes, this folder will be called PRODIKA_HOME.

Installing the Core Application Files

Note: This step needs to be done only once per PRODIKA_HOME. If
you have multiple instances of the Agile PLM suite running on the
same server, you will need to perform this step once per instance.

Throughout the instructions below, the place where you extracted the media bundle
zip file will be referred to as INSTALLER_HOME.

1.

After obtaining the media bundle, extract to a directory on the web application
server.
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Throughout the instructions below, the place where you extracted the media
bundle zip file will be referred to as INSTALLER_HOME.

2. Open the containing directory for INSTALLER_HOME.

3. Extract Core.zip located in INSTALLER_HOME\PDM (where PDM is the name of
the media bundle being installed) to a temporary directory (i.e.; c:\temp). This will

give you a directory structure like c:\temp\Apps, c:\temp\Config, etc. This
temporary directory will be referred to as TEMP_HOME.

4. Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.
5. Open a command prompt and navigate to TEMP_HOME (i.e.; >cd c:\temp).
6. Run the following;:

>FileCompressionHelper.exe -d

Warning: It is extremely important that you perform the
decompression described in step 5 before continuing to install any
additional media pack bundle files.

7.  When the distribution is complete, move your TEMP_HOME contents to
PRODIKA_HOME.

Registering Environment Components
1. Register event logs. Refer to Appendix 1, "Event Logs" for a listing of event logs.

a. Open a command prompt and navigate to INSTALLER _
HOME\Installer\Tools.

b. Run the following batch file:

>SetupEventLogs.bat

c. You will be asked to verify the addition of each event log to your system event

logs. Click Yes/Ok through all of the event log additions.
2. Register Component Art and Apoc.

a. Open a command prompt and navigate to INSTALLER _
HOME\Installer\Tools.

b. Run the following batch file:

>ConfigureRegistry.bat

c. You will be asked to verify the addition of each registry entry. Click Yes/Ok
through all of the event log additions.

3. Install the Remoting Container Service.

Note: This step needs to be done only once per PRODIKA_HOME. If
you have multiple instances of the Agile PLM suite running on the
same server, you will need to perform this installation once per
instance.

a. Open a command prompt and navigate to INSTALLER _
HOME\Installer\Tools.
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b. Stop IIS. From the command prompt type the following:
>iisreset /stop

c. Run the following batch file with <PRODIKA_HOME?> replaced by your
specific PRODIKA_HOME directory:
>InstallRemotingContainerService.bat <PRODIKA_HOME>

d. If you are running a 64-bit system, follow these steps to set up the Remoting
Container to run as a 32-bit process.

a. Download the Windows SDK for Windows Server 2008 and .NET
Framework 3.5 from
http:/ /www.microsoft.com/download/en/confirmation.aspx?id=24826

b. Install the Developer Tools.

c. Note the installation path for corflags. The default is C: \Program
Files\Microsoft SDKs\Windows\v6.1\Bin\.Run the following
command:

corflags.exe /32bit+ %$PRODIKA_
HOME%\RemotingContainer\RemotingContainer.exe

Setting the Remote Container Service and Application Pool Accounts

The remote container service and application pool are standard Microsoft Windows
services, which require user accounts in order to run. During the Agile installation, the
service is installed as the Local System account.

To change the account which the service runs under:

1.
2.

3
4.
5
6

Select Start > Administrative Tools > Services.

Locate the RemoteContainerService within the list of services listed in the Services
dialog box.

Right-click the RemoteContainerService row and select Properties.
Select the Log On tab.
Select the This account radio button.

Select the PLM4P_AppUser account defined in the Pre-Installation section.

Before installing Agile PLM for Process, make sure that your IT department has
created an account for each service for you. Such accounts can be system accounts,
local Windows accounts, or domain accounts (active directory). The process for
creating a remote container service account and application pool account is a standard
approach for creating Windows accounts.

Warning: If utilizing Integrated SSPI in the database
connectstring, then the logon account for the remote container
service needs to be a user with datareader and datawriter rights for
the database.
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Installing Individual Media Bundle Application Files
1. Open the containing directory for INSTALLER_HOME.

2. Extract the media pack zip file located in INSTALLER_HOME to a temporary
directory (i.e.; c:\temp). This will give you a directory structure like
c:\temp\config, c:\temp\FileCompressHelper_CentralDirectory & c:\temp\ Web.

3. Confirm media bundle names for the ZIP files, where the name can be one of:

= MP1.zip for the PDM install

= MP2.zip for the FC install

= MP3.zip for the PSC install

= MP4.zip for the NPD install
4. Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.
5. Open a command prompt and navigate to TEMP_HOME (i.e.; >cd c:\Temp).

6. For all of the media bundles other than the NPD media bundle, run the following
utility application:

>FileCompressionHelper.exe -d

7. When the distribution is complete, move your TEMP_HOME contents to PRODIKA_
HOME.

8. Accept the warning(s) to overwrite the directories that already exist.

Setting Up the Initial IIS Application Pools

We recommend that you run the suite of applications under multiple application pools
in order to provide better resource management and security. At a minimum, GSM
needs to be in its own app pool, segmented from the rest of the applications.

The utility scripts are designed to place the different applications under the same
application pool, or you may run the SetupVirtualDirectories.bat file
manually giving the values for the specific web applications to segment them as you
see fit.

Note: This is a minimum application pool configuration. Depending
on usage, it may be necessary to split out other applications into their
own application pool.

For a 32-bit .NET application running on a 32-bit OS, application pool
memory should not exceed 800 MB. For a 32-bit NET application
running on a 64-bit OS, application pool memory should not exceed
2.3GB.

Keep this in mind when determining how to separate your
applications. Some examples of possible applications to separate
include NPD, SCRM, and GSMView.

The general process of installing the necessary web applications using the utility
scripts is listed below:

1. Open a command prompt and navigate to the directory INSTALLER _
HOME\Installer\Tools.

2. To install the core Web site virtual directories, choose one of the following options:
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= Option 1, Creating a single app pool—To install the core Web site virtual
directories, type the following where the values <PRODIKA_HOME>,
<siteid> and <AppPool> are replaced with the values associated with your
specific environment:

SetupCoreVirtualDirectories.bat <PRODIKA_HOME> <siteid> <AppPool>

= Option 2, Segmenting the applications into separate application pools—To
manually create the virtual directories needed for the individual applications
within the core application bundle, type the following. You will need to repeat
this script for each of the different applications within core. Refer to the
SetupCoreVirtualDirectories.bat file to determine the applications
within core.

SetupVirtualDirectories.bat drl <siteid> <PRODIKA_HOME> <AppPool> drl

Note: Please refer to the section"Determining a Web Site’s Site ID" on
page 1-22 to determine the value for <siteid>.

3. Each media bundle has an associated
Setup<MediaBundle>VitualDirectories.bat batch file where
<MediaBundle> is PDM, FC, SupplierCollab or NPD. To install the necessary
virtual directories for each installed media bundle, repeat the process outlined in
step 2, replacing <Media Bundle> appropriately.

Registering .Net version 2.0 under ASP
1. Open a command prompt and navigate to INSTALLER_HOMEN\Installer\Tools.

2. Run the following command:

>RegisterASP_2_0.bat

Installing the Reference Database

There is a reference database that is located under INSTALLER_HOME\Database.
Restore this database to your database server by following the instructions outlined
under the "Restoring the SQL Database and Setup Database Accounts" on page 1-13
and "Setting Up User Permissions" on page 1-14 section earlier in this guide.

Installing Language Support for Simplified Chinese, Traditional Chinese, Korean, or
French

As an optional step, customers may apply 6.1.0.0.0 National Language Support (NLS)
installation. See Appendix C, "Installing National Language Support" for instructions.

Configuring Applications
Review the Agile Product Lifecycle Management for Process Configuration Guide to apply

the configuration changes required for the installation.
Configuring the Oracle Database Connection
To configure the Oracle Database Connection:

1. Change the Database Connection pools as shown below. The ADAPTER _
FACTORY needs to have the Oracle specific ADAPTER_FACTORY. The format of
the CONNECT_STRING is different from the default SQL Server settings.
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<ConnectionPools>
<ProdikaDB configChildKey="key">
<config key="MAX" value="8"
configOverrideModifier="IsLocked"/>
<config key="CONNECT_ STRING" value="User Id=<ORCL DB
USER>; Password=<ORCL DB PWD>;Data Source=<DATASOURCE>"
configAttributeOverrideBehavior="Replace"
configOverrideModifier="IsLocked"/>
<config key="ADAPTER_FACTORY"
value="Class:Xeno.Data.Oracle.OracleDbAdapterFactory,DataLib"
configAttributeOverrideModifier="CanExtend" />
</ProdikaDB>
<ReportDB copyOf="ConnectionPools/ProdikaDB">
<config key="CONNECT_STRING" value="User Id=<ORCL DB
USER>; Password=<ORCL DB PWD>;Data Source=<DATASOURCE>" />
</ReportDB>
</ConnectionPools>

Note: You should change the connect string in the
environmentvariables.config file.

2. Add the EQT Service config in the EnvironmentSettings and specify the DBHelper
to be Oracle Specific DB Helper as shown below:

<Prodika>
<Services>

<EmailService configChildKey="name">
<envvar name="EMAIL_DOMAIN_FILTER" value="<YOUR EMAIL DOMAIN - ex:
oracle.com" configOverrideModifier="IsLocked"/>
<envvar name="BCC_AUDIT EMAIL_ADDRESS" value=""
configOverrideModifier="IsLocked"/>
<envvar name="SMTP_SERVER" value="<YOUR SMTP ADDRESS>"
configAttributeOverrideBehavior="Replace"
configOverrideModifier="IsLocked"/>
</EmailService>
<EQTService configChildKey="name">
<envvar name="DBHelper"
value="Xeno.Prodika.EQT.Execution.OracleDBHelper, EQT" />
</EQTService>
<SyndicationService configChildKey="name">
<envvar name="ErrorNotifyFromAddress" value="#CUSTOMER_FROM@CUSTOMER.COM"
configElementOverrideModifier="IsLocked"
configAttributeOverrideModifier="Replace" />
<envvar name="ErrorNotifyToAddress" value="#CUSTOMER_TOQRCUSTOMER.COM"
configElementOverrideModifier="IsLocked"
configAttributeOverrideModifier="Replace" />
</SyndicationService>

</Services>
3. Restart IIS. You can now use the Prodika installation on the Oracle Database.

Configuring Access to the Database
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Every server, regardless of its location, will need access to the database:
s For MSSQL, port 1433
s For Oracle DB, port 1521
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Configuring Firewall Access

Both Supplier Portal and eQ have applications that reside inside the firewall. Supplier
Portal and Supplier eQ use a web service to interact with documents via DRL, and this
web service must be accessible through the firewall.

To do this, you must:

= Allow standard port 80 or 443 from Supplier Portal to the DRL web service
through your firewall.

= Modify your %PRODIKA_HOME%\config\environmentvariables.config as
follows

- Add Prodika.Server2.URL = http://server.domain.tld *
- Change Prodika.DRLAttachment.URL = @@VAR:Prodika.Server2. URL@@/drl
— Change Prodika.DRL.URL = @@VAR:Prodika.Server2. URL@@/ dr]

* This URL should match the URL configured in the intranet
environmentvariables.config.

Installing Bl Publisher (Optional)

As an optional step, you can install BI Publisher for Printing and/or Reporting. See
Appendix D, "Installing BI Publisher" for more information.

Completing Optional Steps

For the NPD media bundle, create the WebDAYV folder. Some parts of the Agile suite
use WebDAYV to allow in-place editing of certain document types. To allow for this, a
setting is available in the <PRODIKA_HOME> /config/Custom/
EnvironmentSettings.config file for the WebDAYV virtual folder. In cases for which
WebDAV is required, create a WebDAYV virtual folder and allow the anonymous user
to access (read and write) the physical folder location on the hard drive. Refer to
Appendix B, "Installing WebDAV" for instructions.

Determining a Web Site’s Site ID
To determine the Site ID for a new Web Site within IIS 6.0:

1. Open IIS Manager via Administrative Tools.

2. Expand <server_name> node in the left pane.
3. Highlight the Web Sites node in the left pane.
4

The web sites and their corresponding ID will be listed in the right pane, as
Figure 1-3 shows.
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Figure 1-3 Web sites and IDs
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Post-Installation Checklists

This section discusses tasks that an Agile implementer must complete after installing
the Agile application suite.

Setting the IIS Event Viewer Logging

Warning: This step is critical to successfully running the Agile
application suite. You must set the Event Viewer logging to
"Overwrite events as needed" for System, Security, Application, and
all Agile-created event logs.

If an event log is set to Overwrite events older than 7 days, then you may run into an
issue when a new feature is introduced that uses multiple Warnings, Errors, or
Information. The introduction of new event logging can fill up the event log so that no
more events can be logged, throwing an exception back to the user of the application.
The exception will not go away until the log is set to Overwrite events as needed or
until the log is cleared manually. For this reason, we suggest setting all event logs to
Overwrite events as needed.

Warning: You will need to start up every Agile application, which
will generate a new event viewer log. Review each event viewer
setting to make sure the "Overwrite events as needed" option is
selected.

To set the IIS Event Viewer Logging in IIS 6.0:

1.
2.

On your desktop, right-click the My Computer icon.

Click Manage from the fly-out menu to display the Computer Management dialog
box.

In the left pane, click System Tools > Event Viewer to display all of the available
event viewers.

Right-click on each event viewer and select Properties to display the Application
Properties dialog box.

Select the Overwrite events as needed option.

Click Apply, and then click OK.

Updating the Version Number in the version.txt File

Modify the version.txt file as follows:

1.
2.
3.

In your Prodika_Home directory, locate the version. txt file.
Open the file with a text editor.
Edit the first line so that it contains only the following text:

Version: v6.1.0.0.0

Click File > Save to save the change.
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Starting the Remote Container Service

To start the remote container service:

1.
2.

©® N o g k0

Right click My Computer.

Select Manage from the context menu. The Computer Management console will
open.

Expand the Services and Applications node.
Select the Services node.

The services will be listed in the main content area.
Locate the RemoteContainerService.

Right click and select Start.

Wait a few seconds to verify that it starts and stays running.

Note: For troubleshooting purposes, if the service starts and then
stops, check the log file under

<PRODIKA_HOME>\logs\remoteContainer-stdout.log

to determine the root cause.

Note: For additional troubleshooting ONLY, the remote container
service can be run from the cmd line as follows:

<PRODIKA_HOME>\remotingcontainer\remotingcontainer
/normal

Microsoft .NET Framework

After installing Microsoft NET Framework 3.5 SP1, you need make some
configuration changes to the machine.config file for performance optimization
purposes.

Make the following updates to the machine. config file as follows:

1.

Locate and open the machine.config file at:

C:\Windows\Microsoft .NET\Framework\v2.0.50727\Config\machine.config

Locate the system.web tag and add the following under it:

<pages validateRequest="true" enableEventValidation="false"/>
<processModel enable="true" timeout="Infinite"
idleTimeout="Infinite"

shutdownTimeout="00:00:05" requestLimit="Infinite"
requestQueueLimit="5000" restartQueueLimit="10"
memoryLimit="60" webGarden="False" cpuMask="O0xffffffff"
userName="SYSTEM" password="AutoGenerate" logLevel="Errors"
clientConnectedCheck="00:00:05"
comAuthenticationLevel="Connect" comImpersonationLevel="Impersonate"
responseDeadlockInterval="00:03:00"
responseRestartDeadlockInterval="00:03:00" autoConfig="True"
maxWorkerThreads="20" maxIoThreads="20" minWorkerThreads="1"
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minIoThreads="1" serverErrorMessageFile="" pingFrequency="Infinite"
pingTimeout="Infinite" maxAppDomains="2000" />
<machineKey

validationKey="B3B1257C1B375B1190AF16044C40A42739DEDDBA26C2FIDA35B20FC20C3F63B1
1B22C6B92D602EB8886E3D18F9548B84A0B80EBADC575C407ED33F39ACE08389"
decryptionKey="6D53B0178EF6AA0604C1D559B0962228B7449DAFD920113B"
validation="SHAl"/>

Note: Sometimes, these tags might exist prior to this step. If these
tags are already present, please update them to look as above.

Locate forms Attributes in either web.config or web.config.comments. (The xpath to
the node is: /configuration/system.web/authentication.)
[@mode="Windows'] /forms

Change the protection attribute on the forms tag to None.

Open Internet Information Server Administrator and right-click on the Web virtual
folder and choose Properties.

Click on the ASP.NET tab to confirm that .NET 2.0 is selected.

Refer to Appendix A, "Verification Tests" for instructions on performing tests to verify
the installation.
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Upgrading

This chapter discusses upgrading Agile PLM for Process. Topics in this chapter
include:

s Pre-Upgrade Tasks

s Upgrade Tasks

= Web Application Tasks

= Stopping Services and Backing Up Files

» Installing Software and Scripts

= Reconfiguring Settings

= Restarting Remote Container Service and Web Application Server

s Verifying the Installation

Pre-Upgrade Tasks

Install 6.0.0.3.36

Note: Before upgrading to 6.1, you must install 6.0.0.3.36.

Install .Net 3.5 SP1
Prior to installing 6.1, you must install .Net 3.5 SP1.
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Pre Database Upgrade Procedures

Prior to running the database upgrade using ApplyScripts, you must run the pre_
v61000_upgrade. sql script. Please note that this file contains sql statements for
SQL Server and Oracle. Please only execute the statements that are for the database
you are running. This script identifies the following data problems:

1. Verify that there are no 14 digit GLN numbers.

Warning: If you do not resolve the problems identified by the
script prior to upgrading, the database change will result in
truncation of any GLNs that have more than 13 digits.

2. Verify there are no cases where non-English doubles are stored as a string on
elements such as min/max range on breakdowns and alternate packaging units.

Warning: If you do not resolve the problems identified by the
script by entering the values using decimals instead of commas
prior to upgrading, the values entered in the min/max range and
alternate packaging units will be converted by the system to a
double and the comma will be ignored. This could cause your data
to be misrepresented.

For example, 50,5 will be converted to 505 unless it is changed to
50.5.

3. Check to see if the new ISO codes being added for core nutrients are the same as
ISO codes currently being used by the customer.

Warning: If you do not resolve the problems identified by the
script by changing the duplicate ISO codes used for UOM’s entered
in Data Admin in the "Other" category, the system will fail to load.

Determine Database Executor Role

The database user must have the ability to execute stored procedures on the PLM4P
database. For an MSSQL database where the user is not dbowner, you may need to
add a new database role and grant this role to your database user. Please consult your
database administrator for any conflicts.

1. Run the following to create the role

CREATE ROLE db_executor
GRANT EXECUTE TO db_executor

2. Grant this role to your db user (ex. PLM4P_AppUser)
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Upgrade Tasks

This chapter discusses the basic steps required to upgrade the Agile application suite
to the 6.1 version. The main steps in the upgrade process include:

1. "Check for Active Web Application Server Sessions" on page 2-4
"Stop the Web Application Server" on page 2-5

"Stop the Remote Container Service" on page 2-5

"Back Up the Previous Database Deployment" on page 2-5

"Back Up the Previous Oracle Database Deployment" on page 2-6
"Install the Agile 6.1 Upgrade Software" on page 2-7

"Update the Version Number in the version.txt File" on page 2-8
"Apply Database Upgrade Scripts" on page 2-9

© ® N o o & 0O DN

"Configure the Environment Variables Settings" on page 2-10

-y
o

. "Reconfigure the Application Environment Settings" on page 2-10

-
—h

. "Reconfigure the Customer Settings" on page 2-11

—y
N

. Apply extensions, if any

-y
w

. "Restart the Remote Container Service" on page 2-11

-y
Y

. "Restart the Web Application Server" on page 2-11

-y
[$)]

. "Verifying the Installation" on page 2-12
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Web Application Tasks

Check for Active Web Application Server Sessions

Before bringing down the Web application server, perform two checks to make sure
there are no active user sessions on the server.

Note: We recommend that you notify all users in advance that you
are performing the upgrade, to give them time to shut down their
connections.

Check the Performance System Monitor for Active Sessions

Using Performance System Monitor, check to see how many people currently have
active sessions.

1.
2

10.

Select Start > Run.

In the Run dialog box, type per fmon and click OK to bring up the Performance
dialog box.

Select the System Monitor option in the left pane to bring up the System Monitor
dialog box.

In the bottom portion of the System Monitor dialog box, a list of counters is
displayed. Right-click in this area and select Add Counters from the shortcut
menu to display the Add Counters dialog box.

Select the Select Counters from Computer option and select your Web application
server.

From the Performance Object drop-down list, select ASPNET Apps v2.0.50727.

Select the Select Counters From List option and from the associated scrolling list,
choose Sessions Active, and then click Add.

Click Close to close the Add Counters dialog box.

Using the new active sessions counter, you can view the active sessions for the
Web application server by selecting its row in the counter list at the bottom of the
System Monitor dialog box. In particular, look at the number of active sessions in
the Last field. If this number is greater than 2 active sessions, it is likely that users
are logged on to the server. Contact the user(s) to have them log off before you
shut down the Web application server.

You can save the active sessions counter by right-clicking it and selecting Save As
from the shortcut menu. You may wish to save this counter to your desktop for
future use.

Check the Event Viewer for Last Login

Using IIS Computer Management, check the Event Viewer log for Agile to see when
the last user login occurred.

1.

2.
3.

Right-click My Computer and select Manage from the shortcut menu to display
the Computer Management dialog box.

Under System Tools, select Event Viewer.

Locate and double-click the Portal-Prodika log under Event Viewer.
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4. Review the log to see when the last user login occurred. If a recent login has
occurred, it is likely that a user is still logged on to the server. Contact the user to
have them log off before you shut down the Web application server.

Stop the Web Application Server

After you have verified that there are no active sessions on the Web application server,
bring the server down as follows:

1. Open a command prompt.
2. Enter the following command to stop the Web application server:

C:\Documents and Settings\Administrator>iisreset /stop

Stopping Services and Backing Up Files

Stop the Remote Container Service

Using IIS Computer Management, stop the remote container service as follows:

1. Right-click My Computer and select Manage from the shortcut menu to display
the Computer Management dialog box.

2. Under Services and Applications, select Service to display a list of services in the
right pane.

3. Locate the RemoteContainer Service and click it.

4. Select the Stop the Service option in the top left-hand portion of the Services pane.

Back Up the Previous Database Deployment

Using SQL Server Enterprise Manager, back up the previous deployment of the
database. Be sure to use a meaningful name for the backup for future reference; for
example, Agile 5.2.1 - Full Backup.

Note: The database server must be running in order to perform the
backup.

1. Open SQL Server Management Studio.
In the left pane under Databases, locate the database instance to back up.

Right-click the database and select Tasks > Back Up... from the shortcut menu.

P w N

Select the destination for your backup. Select the Add... button to the right of the
Back up to: text area. A dialog box will appear in which you can choose where to
store the backup file. After you have chosen a name, click the OK button.

5. Click the OK button at the bottom of the dialog and the backup process will begin.
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Back Up the Previous Oracle Database Deployment

Recovery Manager (RMAN) is the recommended method of backing up your Oracle
database and may be accessed via Enterprise Manager.

Note: We recommend you create a full backup of the whole
database.

1. Open Enterprise Manager.
2. Configure backup settings.
a. Select Enterprise Manager > Availability > Backup Settings.

b. Set the disk backup location and backup type. Be sure to use a meaningful
name for the backup for future reference.

3. Schedule the backup.
a. Select Enterprise Manager > Availability > Schedule Backup.

b. Select either the Oracle-Suggested Backup strategy or your own customized
strategy. The Oracle-Suggested Backup strategy makes a one-time
whole-database backup. To use the Oracle strategy, for backup type, select Full
Backup. For Schedule, select One Time (Immediately).

4. Review and submit the backup. The Review screen allows you to review your
selections and submit the job.
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Installing Software and Scripts

Install the Agile 6.1 Upgrade Software

The upgrade process is a manual process that uses batch files. The number of steps
during the upgrade process is determined by the applications that you utilize within
your installation.

For each installation, you will need to install the Core package first. This package
needs to be installed only once per server instance.

After installing the Core package, depending on your installation, you will install one
to four media packs. Each media pack is installed in the same manner outlined below.

Set Up the Installation Environment

Note: This step is common to all media pack installations.

Download the Media Pack installation file for the specific media pack being installed.
Unzip the media pack zip archive to a temporary directory (i.e.; :\INSTALL_HOME).
Follow the directions detailed below for Core/Media Pack installation.

Upgrade the Software

Archiving the Previous Installation

The first step in the upgrade process is to manually archive the previous installation,
as described below.

1. Move (i.e.; cut) all of the directories other than attachments/XDocuments and logs
directories to your designated archive location. We recommend that you name the
containing directory as the version that you are upgrading from (i.e.; v5.1.2 -
installation, etc.).

Installing the Core Bundle

2. The next step in the upgrade process is installing the Core bundle.

Note: This should be done only once per PRODIKA_HOME, meaning
that if you have multiple installations of the Prodika suite of
applications running on the same server, you will need to perform this
step only once per Prodika installation.

Throughout the instructions below, the place where you extracted the media bundle
zip file will be referred to as INSTALLER_HOME.

3. Open the containing directory for INSTALLER_HOME.

4. Extract Core.zip located in INSTALLER_HOME to a temporary directory (i.e.;
c:\temp). This will give you a directory structure like c:\temp\ Apps,
c:\temp\Conlfig, etc. - this temporary directory will be referred to as TEMP_HOME.

5. Copy FileCompressionHelper.exe from INSTALLER HOME to TEMP_HOME.

6. Openacommand prompt and navigate to TEMP_HOME (i.e.; >cd c:\temp)

Upgrading 2-7



Installing Software and Scripts

Run the following (it is extremely important that you perform this decompression
before moving on to install any additional media pack bundle files):

FileCompressionHelper.exe -d

When the distribution is complete, move the contents of TEMP_HOME to PRODIKA_
HOME.

Upgrade the Media Pack Applications

For each media bundle you will follow the same nine step process below. The one
exception is with the NPD media bundle installation. With NPD, there is no need to
perform step 6.

1.
2

If there are any files remaining in your TEMP_HOME, remove them.

Unzip the media pack zip file located in your INSTALLER_HOME directly to TEMP_
HOME.

Confirm media bundle names for the ZIP files, where the name can be one of :

= MP1.zip for the PDM install

= MP2.zip for the FC install

= MP3.zip for the PSC install

= MP4.zip for the NPD install

s MP-ALL.zip which includes all of the media bundles in one zip file

Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.
Open a command prompt and navigate to TEMP_HOME (i.e.; >cd c:\Temp).

Run the following (it is extremely important that you perform this decompression
before moving on to install any additional media pack bundle files):

FileCompressionHelper.exe -d
When the distribution is complete, move the contents of TEMP_HOME to PRODIKA_
HOME.

You will receive a warning that a Web and config directory already exist; accept
this to move the contents into these directories.

Accept the warning to overwrite the configuration file PRODIKA_
HOME\Config\Core\FeatureDeployment\<media
pack>-FeatureConfig.config.

Update the Version Number in the version.txt File

Modify the version.txt file as follows:

1.
2.
3.

In your Prodika_Home directory, locate the version. txt file.
Open the file with a text editor.
Change the first line so that it contains only the following text:

Version: v6.1.0.0.0

Click File > Save to save the change.
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Apply Database Upgrade Scripts

Warning: It is very important that you back up the database as
indicated in "Back Up the Previous Database Deployment" on
page 2-5 before upgrading the database. Once the scripts have been
applied, there is no way to revert the database to the previous state
without a backup.

Note: You must have upgraded to 6.0.0.3.36 prior to upgrading to
6.1.

Applying PKID Migration
This applies to MSSQL customers, only. If you are running Oracle DB, please skip this
step.

To improve overall performance of the application, it is required to run the pkid
migration utility as part of Agile Product Lifecycle Management for Process
Extensibility Pack 2.5. Please refer to the Extensibility Pack for instructions on how to
complete this upgrade task.

Run Database Upgrade Script

To run the database upgrade script:

1. Open a command prompt and navigate to the directory where you unzipped the
upgrade package.

2. Change directories (cd) to the Installer/ ApplyScripts directory.
3. Apply the scripts using the following call to the ApplyScripts.exe utility:
s If running the SQL Server database upgrade:

ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.0.xml

The upgrade script file is:
v6.1.0.xml—Upgrade from v6.0 to v6.1

s If running the Oracle database upgrade:

ApplyScripts -c "user id =<user id>;password=<password>;data source=<data
source>"-dbvendor=orcl -pre ora_cert_fi.pl.sql ora_cert_fi.p2.sql ora_cert_
fi.p3.sql -f v6.1.0-orcl.xml

The upgrade script file is:
v6.1.0-orcl.xml—Upgrade from v6.0 to v6.1

4. Confirm that the database upgrade script has been applied successfully when the
system prompts you with the following message:

“Complete - with no errors”

Upgrading 2-9



Reconfiguring Settings

Applying Language Packs

For instructions on installing language packs, see "Installing National Language
Support" on page C-1.

Applying Bl Publisher

For instructions on installing BI Publisher, see "Installing BI Publisher" on page D-1.

Reconfiguring Settings

Configure the Environment Variables Settings

Using a text-based editor, open the environmentvariables.config file and
update the server names and port addresses.

Reconfigure the Username and Password Settings

With the 6.1 release, the DRL web service username and password settings have been
removed from environmentvariables.config and must now be configured
using the Setup Assistant tool. The default username value in the Setup Assistant is
prodikaadmin so be sure to update this username and password setting to your previous
DRL user settings. The DRL user must be a valid, active PLM for Process user.

The SQL Server Reporting Services (SSRS) and the BI Publisher username and
password settings have also been removed from environmentvariables.config
and added to the Setup Assistant tool. If you are using SSRS and/or BI Publisher for
Printing and/or Reporting, you must enter these settings into the Setup Assistant tool.
These user settings are not Agile PLM for Process users—rather, they are users created
through SSRS and BI Publisher.

Note: For further guidance, please refer to the “Environment
Variable Settings” section of the Agile Product Lifecycle Management for
Process Configuration Guide.

Reconfigure the Application Environment Settings

Using a third party diff tool, you will need to reconfigure the
environmentSettings.config file located in your Prodika_Home\Config\
directory.

To reconfigure application environment settings:

1. Rename the new environmentSettings.config file; change the name to
environmentSettings.config-new.

2. Make a backup copy of the archived version of the
environmentSettings.config file (from the archived directory) and copy it
into the Prodika_Home\Config\Custom\ directory.

3. Using the diff tool, compare the environmentSettings.config-new file to
the archived copy of the environmentSettings.config file.

4. When you have completed the file comparison and updates, delete the copy that
you made of the archived environmentSettings.config file.
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5.

Rename the environmentSettings.config-new file; change the name back to
environmentSettings.config.

Reconfigure the Customer Settings

Using a diff tool such as WinMerge, you will need to reconfigure the
CustomerSettings.config file located in your Prodika_Home\Custom\
directory.

To reconfigure customer settings:

1.

Rename the new CustomersSettings.config file; change the name to
CustomerSettings.config-new.

Make a backup copy of the archived version of the CustomerSettings.config
file (from the archived directory) and copy it into the Prodika_
Home\Config\Custom\ directory.

Using the diff tool, compare the CustomerSettings.config-new file to the
archived copy of the CustomerSettings.config file.

Carefully merge any configuration differences for your particular customer needs.

When you have completed the file comparison and updates, delete the copy that
you made of the archived CustomerSettings.config file.

Rename the CustomerSettings.config-new file back to
CustomerSettings.config.

Reconfigure the DRL Web Service Username and Password Settings

With the 6.1 release, the DRL web service settings have been removed from
environmentvariables.config and must now be configured using the Setup
Assistant tool.

Restarting Remote Container Service and Web Application Server

Restart the Remote Container Service

Using IIS Computer Management, restart the remote container service:

1.

Right-click My Computer and select Manage from the shortcut menu to display
the Computer Management dialog box.

Under Services and Applications, select Service to display a list of services in the
right pane.

Locate the RemoteContainer Service and click it.

Select the Start the Service option in the top left portion of the Services pane.

Restart the Web Application Server

Using a command prompt, restart the IIS Web application server:

1.
2

Open a command prompt.
Enter the following command:

C:\Documents and Settings\Administrator>iisreset

The Web application server restarts.
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Verifying the Installation

Log in to the Agile user portal and verify that the installation is functioning
correctly. We recommend that you perform a variety of post-installation tests to
ensure that all the applications are functioning correctly. For more information, see
Appendix A, "Verification Tests".
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Working with Multiple Servers

This chapter provides guidance for working with multiple servers. Topics in this
chapter include:

»  Architecture Environment Strategy
=  Topology Example of Production Environment

= Multiple Server Configuration

Architecture Environment Strategy
A good environment strategy supports the following project/business needs:
= Support the application upgrade process.

= Provide a structured process for migration (development, test, user acceptance) of
bug fixes, new features, functionality, and configurations. Specifically focusing on
allowing reasonable access to environments during migration.

= Provide a means for preparing/staging data for transfer into a production
environment.

Figure 3-1 shows a sample environment.
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Figure 3—-1 Sample architecture
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Verifying Environment Strategy

Use the following questions to help verify your environment strategy:
= What is the path for upgrading the application from version x to version y?

= What is the process for testing production issues? Which environments will be
available for testing: Development, QA /UAT, and/or Production?

»  Where will end users be trained on the application?
= Where will extensible solutions be developed?

= Where will hot fixes be initially applied? What is the path for migrating hot fixes
to production?

s Where will data loading be tested /verified?
»  How will multiple tasks be supported?
Also consider the following;:

= Migrating from version x to version y and configuring the application to support
new functionality.

s Testing new functionality and supporting production configurations and hot fixes.

» If the implementation is split into multiple projects, how will different project
teams share environments?

Development
The development environment typically is used as a place to:
= Deploy new releases (first place)
= Develop extensible solutions

= Use for initial test and troubleshooting
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= Use for prototyping and discovery

= Make configuration changes, which are then applied in QA

Quality Assurance/User Acceptance Testing

The Quality Assurance (QA)/User Acceptance Testing (UAT) environment typically is
deployed to closely match the Production environment, and is used as a place to:

s Include load balancers, etc.

= Formally test configuration changes

»  Perform periodic refreshes from the Production environment
s Consider data security/access

s Perform training tasks

Production/Export

The Production/Export environment typically is used as a place to:
m Perform data/user/workflow administrative tasks
= Actas the data staging/acceptance environment

s Complete administrative data changes , then export the changes to other
environments

Note: The Production/Export environment must be on same version
as import environments.

Production/Import

Export/Import

The Production/Import environment typically is used as a place where:
s The user community interacts with data on a day to day basis.

=  Administrative data changes are pushed from the export environment to the
import environment

= Configuration changes are pushed from QA

If an environment has applications servers to support the export and import structure,
then note the following;:

The general business process:

= Admin creates records via the export application.

= Admin exports records via the export application.

=  Admin imports record via the import application.

Applications that support the export/import process:

= User Group Manager (UGM)—Users and groups are exported and imported
s Workflow Administration (WFA)—Workflows are exported and imported

= Data Admin (ADMN)—Allergens, additives, extended attributes, and other
administrative data are exported and imported
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When managing the Export/Import structure the databases must be kept
synchronized. If changes are made directly in the import application environment, and
the exact changes (including primary keys) are not applied to the export environment
as well, the Export/Import relationship is broken.

To reestablish the Export/Import relationship the following steps must be performed:
1. Copy or backup the import database.
2. Restore the import database to the export database.

The relationship is now restored. Make changes to data via the export application and
import via the import application.

Imports and Exports are only possible if both environments use the same version.
Example 1—Export v5.2 can push to Import v5.2
Example 2—Export v5.2 cannot push to Import v5.1.2

These examples demonstrate that users, workflows and administrative data cannot be
updated or moved when application versions are different.
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Topology Example of Production Environment

Figure 3-2 depicts the hardware/software topology options for a production
environment.

Figure 3-2 Topology example, Production environment
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Example A, shown in Figure 3-3, highlights:
= Database clustering

= Load balancing

= Separate and centralized file server
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Figure 3-3 Topology Example A
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Topology Example B
Topology B example, shown in Figure 3—4, highlights:
= Standard database
= Logically distributed applications

»  Centralized file server shared with application server
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Figure 3-4 Topology example B
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Multiple Server Configuration

Files Modified

Following are the settings for configuring an environment with multiple servers
running different application modules. Currently, two scenarios are provided. This
includes one for multiple servers with NO reverse proxy, and one for multiple servers
with a reverse proxy.

$PRODIKA_HOME%\Config\EnvironmentVariables.config

$PRODIKA_HOME%\Config\Custom\EnvironmentSettings.config

Recommended Scenario

Customer has chosen to use a reverse proxy or hardware load balancer. Application
URLs should be configured in EnvironmentVariables.config as Client-Server,
meaning it is the URL the client will see and use in Internet Explorer. Web Service
URLs should be configured in EnvironmentVariables.config as Server-Server,
meaning the web service call will NOT be passed to the client.

Table 3-1 Recommended Scenario

Server Name Friendly URL App Modules
RPServer001 plm.xenodev.com n/a

AppServer001 plmappl.xenodev.com GSM, SCRM, Portal
AppServer002 plmapp2.xenodev.com NPD, DRL
AppServer003 plmapp3.xenodev.com WFA, UGM

Note: The main application URL is https://plm.xenodev.com.

SSL Configuration (Optional)

A single SSL certificate will need to be purchased and installed on the reverse proxy or
load balancer, corresponding to the main application URL.

App Configuration

The following is an example, only. There are additional application URLs that are not
listed below.

1. Open the $PRODIKA_HOME%\Config\EnvironmentVariables.config file:
# Server Topology Information
Prodika.Serverl.URL = https://plm.xenodev.com
Prodika.Server2.URL=http://plmappl.xenodev.com

Prodika.SCHEME =https

# Application URL Information
Prodika.GSM.URL=@E@VAR:Prodika.Serverl.URLGR/gsm
Prodika.GSMInterApp.URL=@@VAR:Prodika.Server2.URLGR/gsm

Prodika.SCRM.URL=@Q@VAR:Prodika.Serverl.URLERQ/scrm
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Prodika.NPD.URL=@Q@VAR:Prodika.Serverl.URLCR/npd
Prodika.Portal.URL=@@VAR:Prodika.Serverl.URLGR/portal

# DRL Attachment is used for file upload by the WebApp and
WebService

Prodika.DRLService.URL=@@VAR:Prodika.Server2.URLEE@/drl
Prodika.DRLAttachment .URL=@@VAR:Prodika.Serverl.URLEE@/drl
Prodika.DRL.URL=@@VAR:Prodika.Serverl.URL@Q/drl
Prodika.WFA.URL=@@VAR:Prodika.Serverl.URLGG@/wfa

Prodika.UGM.URL=@Q@VAR:Prodika.Serverl.URLGR/ugm

Result

The application suite is separated on multiple servers. GSM and Portal run on
AppServer001, NPD runs on AppServer002, etc. No matter what application is
opened, the user will always see https://plm.xenodev.com/<module> as the URL in
the browser. Web Service calls, as such for GSMInterApp and DRL, will be passed
internally, from server to server.

Optional Scenario

Customer does not have or has chosen not to use a reverse proxy or a hardware load
balancer. Application URLs should be configured in
EnvironmentVariables.config as Client-Server, meaning it is the URL the client
will see and use in Internet Explorer. Web Service URLs should be configured in
EnvironmentVariables.config as Server-Server, meaning the web service call
will NOT be passed to the client.

Table 3-2 Optional Scenario

Server Name Friendly URL App Modules
AppServer001 plm.xenodev.com GSM, SCRM, Portal
AppServer002 plmapp2.xenodev.com NPD, DRL
AppServer003 plmapp3.xenodev.com WFA, UGM

Note: The main application URL is https://plm.xenodev.com.

SSL Configuration (Strongly Recommended for Production Environments)

An SSL certificate will need to be purchased and installed on each application server,
corresponding to the friendly URL provided.

App Configuration

The following is an example, only. There are additional application URLs that are not
listed below.

1. Open the %PRODIKA_HOME?%\Config\ EnvironmentVariables.config file:
# Server Topology Information
Prodika.Serverl.URL = https://plm.xenodev.com

Prodika.Server2.URL=https://plmapp2.xenodev.com
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Prodika.Server3.URL=https://plmapp3 .xenodev.com

Prodika.SCHEME =https

# Application URL Information
Prodika.GSM.URL=@Q@VAR:Prodika.Serverl.URLCGR/gsm
Prodika.GSMInterApp.URL=@@VAR:Prodika.Serverl.URLGR/gsm
Prodika.SCRM.URL=@@VAR:Prodika.Serverl.URLE@/scrm
Prodika.NPD.URL=@Q@VAR:Prodika.Server2.URLCR/npd
Prodika.Portal.URL=@@VAR:Prodika.Serverl.URLGR/portal

# DRL Attachment is used for file upload by the WebApp and
WebService

Prodika.DRLService.URL=@Q@VAR:Prodika.Server2.URLQRQ/drl (see
note)

Prodika.DRLAttachment .URL=Q@VAR:Prodika.Server2.URLCE/drl
Prodika.DRL.URL=@@VAR:Prodika.Server2.URLCCR/drl
Prodika.WFA.URL=@@QVAR:Prodika.Server3.URLCC/wfa

Prodika.UGM.URL=@Q@VAR:Prodika.Server3.URLCR/ugm

Result

The application suite is separated on multiple servers. GSM and Portal run on
AppServer001, NPD runs on AppServer002, etc. The user will see the corresponding
URL based on the application that is opened. For example, when the user opens GSM,
the user will see https://plm.xenodev.com/GSM as the URL in the browser.
Subsequently, when the user opens NPD, the user will see
https://plmapp2.xenodev.com/NPD as the URL in the browser.
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Verification Tests

Perform the following verification tests after installation or upgrade.

Login Information

Global Specification Management Test
Printing Test

Attachment Test

Reporting Test

Supply Chain Relationship Management Test
Nutrition Surveillance Management Test
eQuestionnaire Test

New Product Development Test

Product Quality Scorecard Test

Component Catalog Test

Computer Aided Compliance Screening Test
Supplier Portal Test

User Group Administration Test

Workflow Administration Test

Manage Core Data Test

Manage Data Caches Test

In order to perform the recommended Agile verification tests, you will need the user
name and password for an Agile user account having access to all Agile applications.
The standard username and password that ships with the certified database is:

Username: prodikaadmin

Password: agile

Warning: After first login, you will be prompted to assign a new
password.
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User access is managed using the User Group Management (UGM) application. For
more information on user management, see the Agile Product Lifecycle Management for
Process Administrator User Guide.

To verify installation:

1.
2.

Turn on Agile PLM for Process.

Access the Agile application using Internet Explorer. Use the following Fully
Qualified Domain Name (FQDN) URL:

https://server.domain.tld/portal

Warning: Be sure to use a fully qualified domain name rather than
just a servername. Example: https://app.prodika.com/portal
vs. https://app/portal.

Type your use name and password, and press the Enter key. You will be prompted
to change your password.

Type a new password in the Password field, and again in the Repeat Password
field, and press the Enter key.

Note: The following installation verification tests assume that you
have installed the entire Agile application suite. If this is not the case,
omit tests for applications that you have not installed.

Warning: You must be assigned the correct Agile roles to perform
these installation verification tests. For more information on roles,
see the Agile Product Lifecycle Management for Process
Administrator User Guide.

Global Specification Management Test

Before performing this test, note that specifications, once created, cannot be deleted
from GSM. Therefore, creating specifications for verification purposes contributes to
the proliferation of meaningless specifications. If specifications already exist in the
system, you may wish to skip this test.

The purpose of this test is to verify that GSM is properly functioning.

To perform the GSM test:

1.

N o g 0 Db

Log in to Agile PLM for Process.

From the left navigation panel, select GSM > Material Specifications.
Click Create New. A new material specification is displayed.

Type a specification name in the Spec Name field.

Complete the Approved for Use In section at the bottom of the page.
Click Save & Close.

From the left navigation panel, select GSM > Material Specifications.
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8. Conduct a blind search by clicking Reset and then Search or specify search criteria
to retrieve the specification that you just created.
9. In the Search Results table, click the row containing the specification you created.
The selected specification is displayed.
10. Click Workflow.
11. Type any value in the Comments field.
12. Click the move step forward icon (E:>). If additional dialog boxes appear, it
confirms that GSM is functioning.
Note: To remove the test data in a production environment, restore
your database, restart the Remoting Container, and then restart the
application pools. This returns the environment to the default
installation state.
Printing Test
The purpose of this test is to verify that the Agile Printing Service is correctly
functioning.

To perform the Printing test:

1. Log in to Agile Product Lifecycle Management for Process.

2. From the left navigation panel, select GSM > Material Specifications.

3. Search for the specification that you created in "Global Specification Management
Test" on page A-2.

4. Click Print in the action menu.

5. In the resulting Print dialog box under Current Specification > Sections, select any
check box.

6. Click Print again. The specification is rendered in PDF format in a separate
window.

7. Close the window once the PDF is successfully displayed and proceed to the next
test. If the PDF does not appear, double-click the file
Prodika\Scripts\Installation\ApocEntry.reg and retry this test.

Attachment Test

The purpose of this test is to verify that the Attachments feature is correctly

functioning.

To perform the Attachment test:

1.

N o g Db

Navigate to any trade specification in GSM.

Select the Supporting Documents tab.

Click Edit to put the specification in edit mode.

Select the Attachments/Procedures link under Supporting Documents.
Click Add New button.

In the Title field, type test.

Click the Browse... button, select a file, and then select Open.
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Note: The size of the selected file must be less than the designated
limit.

8. Click the Upload button. The first upload may take up to 30 seconds to complete.
9. Click Done in the Attachment Detail window.

10. Click Done in the Attachment/Procedures window.

Reporting Test

The purpose of this test is to verify that the Prodika Reporting Service is correctly
functioning.

To perform the Reporting test:
1. Login to Agile PLM for Process.
2. From the left navigation panel, click RPT (Reporting).

3. Search for the specification that you created in "Global Specification Management
Test" on page A-2.

4. Click Generate Report.

5. In the resulting dialog, type a report name in the Report Name field and then click
Save.

6. In the left navigation panel, select Ad Hoc Reports > Reports Queue.

7. The resulting Reports Queue should contain an entry for your report. Refresh this
view periodically by toggling from Reports Queue to Reporting and back, to see
the status of your report update. If the report status fails to update, there is likely a
problem with the Reporting Service.

8. When the report status indicates Complete, click the hyperlinked name of the
report to download the report.

Supply Chain Relationship Management Test
The purpose of this test is to verify that the SCRM application is correctly functioning.

To perform the SCRM test:
1. Login to Agile PLM for Process.
2. From the left navigation panel, select SCRM > Company Profiles.

3. Conduct a blind search and select any company profile from the Search Results
table to verify that it is displayed correctly.

4. If the company profile is displayed, click Cancel and proceed to the next test.

Nutrition Surveillance Management Test
The purpose of this test is to verify that the NSM application is correctly functioning.

To perform the NSM test:

1. Login to Agile PLM for Process.

2. From the left navigation panel, select NSM > Nutrient Analysis.
3. Click Create New.
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4. If the Nutrient Analysis template is displayed, click Cancel and proceed to the
next test.

eQuestionnaire Test
The purpose of this test is to verify the eQ application is correctly functioning.

To perform the eQ test:

1. Login to Agile PLM for Process.

2. From the left navigation panel, select eQ > Material Questionnaires.
3. Click Create New.
4

If the eQuestionnaire page is displayed, click Cancel and proceed to the next test.

New Product Development Test
The purpose of this test is to verify that the NPD application is correctly functioning.

To perform the NPD test:
1. Login to Agile PLM for Process.

2. From the left navigation panel, select NPD > New Product Development >
Projects.

3. Conduct a blind search and select any project from the Search Results table to
verify that it is displayed correctly. If so, NPD has passed the test.

4. If no projects are found, click Create New.

5. Select a business unit and project type in the resulting dialog box and then click
Done.

6. If the NPD (Stage 1) template is displayed, click Cancel and proceed to the next
test.

Product Quality Scorecard Test
The purpose of this test is to verify that the PQS application is correctly functioning.

To perform the PQS test:

1. Login to Agile PLM for Process.

From the left navigation panel, select PQS > Lot Samples.
Click Create New. The Lot Sample page loads.

In the Code Data or Sample ID field, type any text.

Click Next. The Select Specification page loads.

o o & 0 N

In the Specification section, click the search icon ( * / ) next to the Specification
field. A Specification Search dialog box appears.

7. In the resulting Search dialog box, type criteria to find and select the material
specification that you created in "Global Specification Management Test" on
page A-2.

8. If the material specification is displayed, the test has succeeded.

9. Click Close, and proceed to the next test.
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Component Catalog Test

The purpose of this test is to verify that the Component Catalog service is correctly
functioning.

To perform the Component Catalog test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select GSM > Component Catalog.

3. Conduct a blind search and select any catalog term from the Search Results table.
4

If the catalog term is displayed successfully, click Cancel and proceed to the next
test.

a

If no catalog terms are found, click Create New.
6. Type a name for the catalog term in the Component Catalog field.
7. Click Save & Close.

Computer Aided Compliance Screening Test
The purpose of this test is to verify that the CACS application is correctly functioning.

To perform the CACS test:
1. Login to Agile PLM for Process.
2. From the left navigation panel, select CACS.

3. Conduct a blind search and select any computer aided compliance screen from the
Search Results table to verify that it is displayed correctly.

4. If no computer aided compliance screens are found, click Create New.

5. Type a name for the screen in the Title field and a description in the Description
field.

6. Click Save & Close.

Supplier Portal Test

The purpose of this test is to verify that the Supplier Portal application is correctly
functioning. First, log in to Supplier Portal and create a new registrant request:

To register with Supplier Portal:
1. Access Supplier Portal at https:/ /server.domain.tld /supplierportal.

2. Select a Language, and on the login page click click HERE if you have not
registered with this site.

3. Follow the screens, filling out all required data. Once you are done, click Submit.
You have now submitted a registration request. Make note of your User Name and
Password.

To perform the SPA test:
1. Login to Agile PLM for Process as a Supplier Portal administrator.
2. From the left navigation panel, select SPA > New Registrations.

3. The registration request you just submitted should be displayed.
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Note: You need to be a supplier portal administrator to log in to SPA.
Refer to the Agile PLM for Process Extensibility Pack documentation
to find out how to create a supplier portal administrator user. You can
find this documentation in the Agile Product Lifecycle Management for
Process Data Administration Toolkit Guide.

User Group Administration Test
The purpose of this test is to verify that the UGM application is correctly functioning.

To perform the UGM test:
1. Login to Agile PLM for Process.
2. From the left navigation panel, select UGM > Groups.

3. Conduct a blind search and select any group from the Search Results table to
verify that it is displayed correctly.

Workflow Administration Test

The purpose of this test is to make sure that the WFA application is correctly
functioning.

To perform the WFA test:

1. Login to Agile PLM for Process.

2. From the left navigation panel, click WFA (Workflow Administration).
3. Click Create New.
4

If the process template is displayed successfully, click Cancel and proceed to the
next test.

Manage Core Data Test

The purpose of this test is to verify that the ADMN (Manage Core Data) application is
correctly functioning.

To perform the ADMN test:
1. Login to Agile PLM for Process.
2. From the left navigation panel, select ADMN > GSM Compliance > Additives.

3. If the additives currently in the system are displayed successfully, click Cancel and
proceed to the next test.

Manage Data Caches Test

The purpose of this test is to verify that the CACHE application is correctly
functioning.

To perform the CACHE test:

1. Login to Agile PLM for Process.

2. From the left navigation panel, click CACHE (Manage Data Caches).

3. If the Schedule Cache Flush page is displayed successfully, the test has succeeded.

Verification Tests A-7



Verification Tests

You can now use the scheduled Cache Flush Queue feature to see details for the
different applications that been flushed. For more information, refer to the “Using

CACHE to Manage Caches” chapter of the Agile Product Lifecycle Management for Process
Administrator User Guide.
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Installing WebDAV

This appendix contains instructions for installing and configuring WebDAV.

Warning: If you are installing the main application on IIS7.x, then
you must have a separate web server with IIS6 or Apache 2.2
installed for WebDAV.

Enabling WebDAV

To make sure that Web Sharing is enabled in IIS:
1. Open the IIS Manager, and then select Web Service Extensions.

2. Enable WebDAV if it is not already set to “Allowed,” as Figure B-1 shows below:

Figure B-1 Enabling WebDAV
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Creating the Directory Structure

To configure WebDAV:
1. Create the directory structure as follows:
WebDAV\
WebDAV\PDFComments
WebDAV\NPDWorkArea

Figure B-2 Directory Structure

=l 5 webDay
51 MPDWorkarea
I=1 PDFComments

Sharing the WebDAV Directory
To share the WebDAV directory:

1. Right click on the WebDAV Directory and select Properties.

2. Select the Web Sharing tab.

3. Share the folder as WebDAV.

4. Click Edit Properties.

5. Check Read, Write and allow Scripts, as Figure B-3 shows below.

Figure B-3 Properties
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Editing Folder Permissions
To edit folder permissions:

1. Click on the Security tab.

2. Give the user that the Application Pool runs as full control, and apply to all sub
directories, as Figure B—4 shows below.

Figure B-4 Properties
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Verifying the 1IS Directory Security is Configured Correctly

Verifying the IIS Directory Security is Configured Correctly
To verify IIS directory security:
1. Locate the WebDAV virtual directory, then right click and select Properties.
2. Verify that the directory has Write permission, as Figure B-5 shows.

Figure B-5 Virtual Directory
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3. Click the Directory Security tab.

4. Select Edit under Authentication and access control.

5. Verify that Anonymous access is enabled, as shown in Figure B-6.
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Figure B-6 Authentication
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Enabling WebDAV in Apache: (Basic Configuration)

To enable WebDAYV in Apache:

Uncomment the following lines in httpd. conf:

LoadModule dav_module modules/mod_dav.

SO

LoadModule dav_fs_module modules/mod_dav_fs.so
LoadModule dav_lock_module modules/mod_dav_lock.so

Include conf/extra/httpd-dav.conf

Sample httpd-dav.conft:

DavLockDB "C:/Program Files (x86)/Apache Software

Foundation/Apache2.2/var/DavLock"
Alias /webdav "c:/webdav"
<Directory "c:/webdav">

Order Allow,Deny

1. Install Apache 2.2.
2.
3.
Dav On
Allow from all
</Directory>
4.

Create DavLock dir based on setting

in httpd-dav.conf.
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Configuring the Application
To configure WebDAV for a single server setup:

1. Edit Environment Settings under
PRODIKA_HOME\custom\config\EnvironmentSettings.config

2. Map the following settings in the config to the appropriate directories/URLS. To
test, you can enable directory browsing on the web dav virtual directory.

s <config key=“PDFWorkArea”
value=“https://demo.prodika.com/WebDAV/npdworkarea/"”; />

m <config key=“PDFWorkAreaUNC”
value="C:\WebDAV\NPDWorkArea\” />

m <config key=“"PDFCommentRepository”
value=“https://demo.prodika.com/WebDAV/PDFComments”; />

s <config key=“"PDFCommentRepositoryUNC”
value="C: \WebDAV\PDFComments\” />

s <config key=“0fficeDocWorkArea”
value=“https://demo.prodika.com/WebDAV/npdworkarea/"”; />

m <config key=“"0fficeDocWorkAreaUNC”
value="C:\WebDAV\NPDWorkArea\” />

Note: If Apache is using a non-standard HTTP port, then you will
need to reflect that in your environmentsettings.config file. For
example:

https://demo.prodika.com:8080/webdav/npdworkarea/

To configure WebDAYV for a multiple server setup:

1. Share the web dav directory as webdav on server A resulting in \\<server
a>\webdav

2. Set appropriate share and security permissions as follows:

The user running app pool on server B must have RW share and security access to
\\<server A>\webdav.

3. Use \\<hostname>\webdav\pdfcomments\ and \\<server
A>\webdav\npdworkarea for UNC paths in config on server B.
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Installing National Language Support

This appendix contains instructions for installing and configuring National Language
Support (NLS).

Installing Language Support for Simplified Chinese, Traditional Chinese,
Korean, or French

As an optional installation step, customers may apply 6.1.0.0.0 National Language
Support (NLS).

Pre-Upgrade Checklist

1. Archive the previous installation.
2. Back up your current database.
3. Stop the Remoting Container service.
a. Open Services > Start > Administrative Tools > Services.
b. Locate the RemoteContainerService service and perform a Stop operation.
4. Stop IIS. From a command prompt, type the following:

> iisreset /stop

Note: Specific fonts are used when displaying these language
characters in the UI as well as when printing. Verify you have the
following fonts installed on the server:

Simplified Chinese: SimSun
Traditional Chinese: SimSun

Korean: Gulim

Apply Database Scripts
To apply the 6.1.0.0.0 scripts:

(For SQL Server)

1. Open a command prompt and navigate to the directory where you unzipped the
upgrade package.

2. Change directories (cd) to the Installer/ ApplyScripts directory.
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3. Apply the scripts using the following calls to the ApplyScripts.exe utility:
a. Apply the scripts to load Korean translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f 6.1.0.0.0_
Korean_LangPack-oracl.xml

b. Apply the scripts to load Simplified Chinese translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f 6.1.0.0.0_
Chinese_LangPack-oracl.xml

c. Apply the scripts to load Traditional Chinese translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f 6.1.0.0.0_
ChineseTW_LangPack-oracl.xml

d. Apply the scripts to load French translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f 6.1.0.0.0_
French_LangPack-oracl.xml

4. After the ApplyScripts call, you can confirm that the database upgrade scripts
have been applied successfully when the system prompts you with the following
message:

"Complete - with no errors"

(For Oracle Database)

1. Open a command prompt and navigate to the directory where you unzipped the
upgrade package.

2. Change directories (cd) to the Installer/ ApplyScripts directory.
3. Apply the scripts using the following calls to the ApplyScripts.exe utility:
a. Apply the scripts to load Korean translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data
Source=<datasource>" -dbvendor="orcl" -f 6.1.0.0.0_Korean_
LangPack-oracl.xml

b. Apply the scripts to load Simplified Chinese translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data
Source=<datasource>" -dbvendor="orcl" -f 6.1.0.0.0_Chinese_
LangPack-oracl.xml

c. Apply the scripts to load Traditional Chinese translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data
Source=<datasource>" -dbvendor="orcl" -f 6.1.0.0.0_ChineseTW_
LangPack-oracl.xml

d. Apply the scripts to load French translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data
Source=<datasource>" -dbvendor="orcl" -f 6.1.0.0.0_French_
LangPack-oracl.xml
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After the ApplyScripts call, you can confirm that the database upgrade scripts
have been applied successfully when the system prompts you with the following
message:

“Complete - with no errors”

Post-Upgrade Checklist

1.

Start the Remoting Container Service.

a. Open Services > Start > Administrative Tools > Services.

b. Locate the RemoteContainerService service and perform a Start operation.
c. Verify that the RemotingContainerService started correctly.

Start IIS. From a command prompt, type the following:

> iisreset /start
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Installing Bl Publisher

This appendix contains instructions for installing and configuring BI Publisher.

Bl Publisher for Printing and Reporting

Oracle Business Intelligence Publisher (BI Publisher) has been integrated with the
Printing and Reporting applications. Printing and Reporting have separate
configurations settings, and BI Publisher can be configured for Printing, Reporting, or
both.

Requirements: Please see Figure 1-2, "Software requirements matrix" on page 1-4 for
supported versions of BI Publisher.

When installing BI Publisher, you will be prompted to enter an administrator
username and password for administering the BI Publisher reports. This username
and password will also grant access to a BI Publisher web service used by Agile PLM
for Process to processes printing and reporting requests. To enter these values into
Agile PLM for Process, launch the Setup Assistant tool and enter the username and
password for BI Publisher. For more information, refer to the Agile Product Lifecycle
Management for Process Configuration Guide.

Note that when setting up BI Publisher for Reporting, you will need to set up a
database connection to the Agile PLM for Process database. This may involve
installing relevant JDBC drivers, setting up the DataSource in BI Publisher, and
configuring the connection string and database driver class. Please refer to the Oracle
BI Publisher documentation for details.

Note: The BI URL in environment variables has changed if you are
using the new version, 11.1.1.x, of OBIEE with release 6.1.

Printing Using Bl Publisher

To configure BI Publisher for Printing, you will need to update Agile PLM for Process
configuration settings and set up BI Publisher to process the incoming data using BI
Publisher’s report templates.

Print data is sent to the BI Publisher web service as XML data; the relevant Bl
Publisher report template takes the incoming XML data and can then transform it
using a custom XSL as needed.

Installing Bl Publisher D-1



Bl Publisher for Printing and Reporting

To configure Agile PLM for Process:

1. Update the \config\environmentvariables.config file:

Key Value

Prodika.Print.BIPublisherIntegration.EndP For versions 10.1.3.3 and 10.1.3.4:

oint
http://[hostname]:9704 /xmlpserver/services/
PublicReportService

For version 11.1.1.5:

http://
[hostname]:7001/xmlpserver/services/v2/Secu
rityService | http://
[hostname]:7001/xmlpserver/services/v2/Rep
ortService

Note: Prodika.ReportService.SysUser and SysPassword are now set
using the Setup Assistant. Refer to the Agile Product Lifecycle
Management for Process Configuration Guide for instructions.

2. Update the \config\Extensions\PrintSettings.config file. This file contains the
print configurations for the various print items, such as specifications, NPD
printing, etc. You will need to update this file to use the BIPublisherFORender
print manager:

a. Open the \config\Extensions\PrintSettings.config.

b. Update the specification (or other print item) type you want to print to use the
BI publisher print manager. You can add the following to an existing entry, or
create a new entry:

printmanager="BIPublisherFORender" reportPath="Your custom BI Publisher
report path"

For example:

<PrintTemplate id="Default" library="XSL_FO_LIBRARY"
report="GSM$xlate$.xsl" printmanager="BIPublisherFORender"
reportPath="/ProdikaPrint/ProdikaPrintFO/ProdikaPrintF0O.xdo" />

An optional attribute, reportTemplate, is used to specify which BI Publisher report
Layout to use.

Note that the reportPath value should correspond to the report set up in BI
Publisher.
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To Configure Bl Publisher for Printing:

Setting up BI Publisher for Printing involves creating a BI Publisher report,
configuring its Data Model to link it to Agile PLM for Process, and setting up the
possible layouts. In this section, an example report configuration is presented, but
other configurations are possible.

1. Log in to BI Publisher. For 10.1.3.3 and 10.1.3.4:
http:/ /<YourBIServerURL>:9704 /xmlpserver/
For 11.1.1.5:
http:/ /<YourBIServerURL>:7001/xmlpserver/
2. In the Reports tab, click the Shared Folders link.
3. Create a new folder (ex: ProdikaPrint).

4. In the new folder, click the Create a new report link on the left, enter a report
name (ex: ProdikaPrintFO) and click the Create button.

5. Click the Edit link.

6. Click Parameters, then click the New icon.

Figure D-1 Parameters option, Parameter page

Schedules
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Data Type | str
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'@ RTFTemplate

= Bursting

a. Make entries in the following fields:
Identifier— Enter DocKey. This is a required field.
Data Type—Select String from the drop-down list. This is a required field.
Default Value—Leave this field blank.

Parameter Type—Select Hidden from the drop-down list. This is a required
field.

b. Click Save.
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7. Click Data Model, then click the New icon, as shown in Figure D-2.
Figure D-2 PrintDataModel option, Data Set page
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a. Make entries in the following fields:
Name—Name of the data model. This is a required field.

Type—Select HTTP (XML Feed) from the drop-down list. This is a required
field.

URL—Enter
http://{application URL}/gsm/PopUps/docstream.aspx where
{application URL} is the address of the application. This is a required field.

Method—Select GET from the drop-down list. This is a required field.
b. Click Add to display the Parameters Name and Value fields.
c. Make the following entries:

Name—The name of the parameter that you created in step a. This is a
required field.

Value (Parameter)—Select DocKey from the drop-down list. This is a required
field.

d. Click Save.
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8. Click Layout to set up the report layout.

a. Inthe Manage Template Files section, upload your XSL template to use. In this

scenario, we created and uploaded a simple XSL “pass-through” file called
ReportTemplate.xsl, as such:

<?xml version='1.0'?>
<xsl:stylesheet version="1.0"
xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform">
<xsl:template match="/">
<xsl:copy-of select="/" />
</xsl:template>
</xsl:stylesheet>
However, you can easily create your own transformation rules yourself.

b. Click New to create a new report layout, as shown in Figure D-3.

Note: You can create multiple layouts and then declare the desired
layout in the PrintSettings.config file.

Figure D-3 Layouts, FOTemplate option, Layout page
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c. Make the following entries:
Name—The name of the report layout. This is a required field.

Template— Select XSL Stylesheet (FO) from the drop-down list. This is a
required field.

Template Type— Select the Limit Output Format to radio button, and then
select the PDF checkbox. This is a required field.

d. Click Save.

Your report should now be available for printing. Make sure that the link to the report
matches the reportPath value in the PrintSettings.config file. (While editing
the report in BI Publisher, right-click on the View link in the top right and select Copy
Shortcut to get the value).

If your Printing includes any images, such as logos, make sure they are available to BI
Publisher, by adding them to the BI publisher directory. The location will depend on
the path used.

Reporting Using Bl Publisher

The Agile PLM for Process Reporting application allows clients to organize, configure,
secure, and launch custom reports. The configuration is managed in the
CustomerReportExtensions.xml located in the \Config\Extensions\
directory. Reports and their parameters are presented in PLM for user entry; their
values are then passed to custom BI Publisher reports to process the parameters, query
data sources, and generate the report.

To use BI Publisher for Reporting, you will need to update Agile PLM for Process
configuration settings, set up custom reports in BI Publisher, and update the Agile
PLM for Process Reporting configurations accordingly.

For details on configuring custom PLM reports, refer to the Agile Product Lifecycle
Management for Process Custom Report Configuration Guide.

To Configure Agile PLM for Process:

1. Update the \config\environmentvariables.config file:

Key Value

Prodika.ReportServer.URL For 10.1.3.3 and 10.1.3.4:
http://[hostname]:9704

For 11.1.1.5:
http://[hostname]:7001

Prodika.ReportService. URL Use one of the following;:

Prodika.ReportService.OracleBIPublisher10_1_
3_3.URL

Prodika.ReportService.OracleBIPublisher10_1_
3_4.URL
Prodika.ReportService.OracleBIPublisher11_1_
1_5.URL
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Note: Prodika.ReportService.SysUser and SysPassword are now set
using the Setup Assistant. Refer to the Agile Product Lifecycle
Management for Process Configuration Guide for instructions.

2. Update the \config\Extensions\CustomerReportExtensions.xml file to set up the
custom reports for the Reporting application. Details can be found in the Agile
Product Lifecycle Management for Process Custom Report Configuration Guide.

To Configure Bl Publisher Reports:

Please refer to Oracle BI Publisher documentation for creating and setting up reports
in BI Publisher.
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Skill Set Matrix

Skill Set Matrix

Refer to the following matrix for guidance on what skills are recommended for
members of your technology team.

Figure E-1 Skill set matrix
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Installation Troubleshooting

This appendix contains a list common issues that may occur after installation.

Troubleshooting Tips

The following list details common issues and suggestions for solving them.

1.

How can I compare my recent build with an older build to see if configuration
values have changed?

Tip: Use the Config Rollup URL to check the rolled up configuration settings for
various applications. The URL is:

http://<serverName>/<appName>/WebCommon/AdminForms/ConfigRoll
up.aspx

Clicking upload when adding a DRL attachment causes the window to simply
blink.

Tip: Ensure you've waited at least 30 seconds on the first attempt.

Tip: Ensure the machine.config for your .NET version has the machine key entry.
Message displayed is “trust relationship could not be established”.

Tip: Verify that the Web site your using has a signed certificate.

Tip: If not testing SSL. DRL attachments, configure them to use HTTP and ensure
the “Prodika.GSMInterApp.URL” property is using HTTP.

Message displayed is “The remote certificate is invalid according to the validation
procedure.”

Tip: Be sure to configure the DRL.WebServices.Login and
DRL.WebServices.Password credentials using the Setup Assistant tool. The user
specified should be an Agile PLM for Process user. For more information, refer to
the Agile Product Lifecycle Management for Process Configuration Guide.

NPD edit-in-place documents are read-only.

Tip: The user connecting to the IIS share does not have permissions to the
underlying folder on the server. Grant full permissions by assigning the
‘Everyone’ permission setting on that folder. If that solves the problem, lock down
the folder with tighter permissions.
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10.

The Browser keeps redirecting to incorrect URLs or keeps jumping from HTTPS to
HTTP.

Tip: Make sure that the environmentvariables.config file has the right URLs.

Tip: You can only have one HTTPS site on one machine. If you have more than
one, it bounces back and forth between the two sites

Tip: Make sure that you are not using HTTPS in the URL to access a http Web site.
Using https in your URL will make the Server redirect your request to the default
https Web site.

Tip: Conversely, if the environmentvariables.config file is using https to access a
http Web site, you would be redirected to the default https Web site incorrectly

Navigation to any page in the application results in a blank page after migrating to
another version or a new version of .NET is installed.

Tip: The wrong ASP.NET version may be registered with IIS. Run the “aspnet_
regiis.exe” utility with the “-r” flag.

The rich text dialog box is prompting me with security issues concerning scripts.
Tip: Ensure the page event and request validation are turned off.

What is drl.prodika.com?

Tip: Make sure that you have the new URLs and https:.

I am prompted to login to every application.

Tip: Is the remoting container running?

Tip: Ensure you are using the trust bridge in “EnvironmentSettings.config”.
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